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VHDL

VHDL

VHSIC Hardware Description Language
Very High Speed Integrated Circuit

» digitale Systeme
» Modellierung/Beschreibung
» Simulation
» Dokumentation

» Komponenten

» Standard ICs
» anwendungsspezifische Schaltungen: ASICs, FPGAs
» Systemumgebung: Protokolle, Software . ..
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VHDL (cont.)

» Abstraktion
» von der Spezifikation — Algorithmen und Protokolle
> lber die Implementation — Register-Transfer Modelle
> bis hin zum fertigen Entwurf — Netzliste mit Backannotation

= VHDL durchgingig einsetzbar
= Simulation immer méoglich

Entwicklung

» 1983 vom DoD initiiert

» 1987 IEEE Standard IEEE 1076
» 2004 IEC Standard IEC 61691-1-1

v

regelmaBige Uberarbeitungen
VHDL'93, VHDL'02, VHDL'08, VHDL'19
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VHDL (cont.)

Erweiterungen

» Modellierung und Zellbibliotheken IEC61691-2, IEC 61691-5

» Hardwaresynthese IEC 61691-3-3, IEC 62050

» mathematische Typen und Funktionen IEC61691-3-2

» analoge Modelle und Simulation IEC 61691-6

Links

» https://tams.informatik.uni-hamburg.de/
research/vlsi/vhdl

> https://www.vhdl-online.de

> https://www.itiv.kit.edu/english/721.php
» https://www.asic-world.com/vhdl

» https://en.wikipedia.org/wiki/VHDL

v

https://de.wikipedia.org/wiki/Very_High_ Speed_
Integrated_Circuit_Hardware_Description_Language
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VHDL - sequenziell

» Typen, Untertypen, Alias-Deklarationen
> skalar integer, real, character, boolean, bit,
Aufzidhlung
> komplex line, string, bit_vector, Array, Record
> Datei text, File
> Zeiger Access
» strikte Typbindung
» Konvertierungsfunktionen
» Objekte constant, variable, file
» Operatoren
1 logisch and, or, nand, nor, Xor, Xxnor
2 relational =, /=%, <=, >, >=
3 schiebend sll, srl, sla, sra, rol, ror
4 additiv + -, &
5 vorzeichen +, -
6 multiplikativ * /, mod, rem
7 sonstig ** abs, not
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VHDL - sequenziell (cont.)

> Anweisungen
> Zuweisung 1=, <=
> Bedingung if, case
> Schleifen for, while, loop, exit, next
> Zusicherung assert, report
>

» Sequenzielle Umgebungen
> Prozesse process
> Unterprogramme procedure, function

> lokale Giiltigkeitsbereiche
» Deklarationsteil: definiert Typen, Objekte, Unterprogramme
Anweisungsteil: Codeanweisungen sequenziell ausfiihren

= Imperative sequenzielle Programmiersprache (z.B. Pascal)

> Beliebige Programme ohne Bezug zum Hardwareentwurf moglich
» Beispiel: Datei einlesen, verlinkte Liste erzeugen ...
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VHDL - sequenzieller Code

type

VHDL - sequenziell (cont.)

LIST_P);

LIST_T;
type LIST_PTR is access LIST_T;
type LIST_T is record KEY integer;
LINK LIST_PTR;
end record LIST_T;
constant INPUT_ID string := "inFile.dat";
file DATA_FILE text;
variable DATA_LINE line;
variable LIST_P, TEMP_P LIST_PTR := null;
procedure READ_DATA is -- Datei einlesen, Liste aufbauen
variable KEY_VAL integer;
variable FLAG boolean;
begin
file_open (DATA_FILE, INPUT_ID, read_mode);
Ll: while not endfile(DATA_FILE) loop
readline (DATA_FILE, DATA_LINE);
L2: loop
read (DATA_LINE, KEY_VAL, FLAG);
if FLAG then TEMP_P := new LIST_T’(KEY_VAL,
LIST_P := TEMP_P;
else next L1;
end if;
end loop L2;
end loop L1;

file_close (DATA_FILE);
end procedure READ_DATA;




VHDL - konkurrent

VHDL - konkurrenter Code VHDL-Einfiihrung

» 3hnlich ADA’83
» Konkurrenter Code

> mehrere Prozesse
> Prozeduraufrufe
> Signalzuweisung <=

bedingt <= ... when ...
selektiv with ... select ... <=
> Zusicherung assert

» modelliert gleichzeitige Aktivitdt der Hardwareelemente

» Synchronisationsmechanismus fiir Programmlauf / Simulation
> Objekt signal

» Signale verbinden konkurrent arbeitende , Teile” miteinander
» Entsprechung in Hardware: Leitung
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VHDL - Simulation

VHDL - Simulation VHDL-Einfiihrung

» Semantik der Simulation im Standard definiert: Simulationszyklus
» konkurrent aktive Codefragmente

» Prozesse + konkurrente Anweisungen +
Instanzen (in Hierarchien)
» durch Signale untereinander verbunden

.Wie werden die Codeteile durch einen sequenziellen
Simulationsalgorithmus abgearbeitet?"

» Signaltreiber: Liste aus Wert-Zeit Paaren

. (Now | +5ns | +12ns | +15ns | +21ns | +27ns |  Zeitpunkt
S: integer —=
2 7 3 12 8 -3 J Wert

» Simulationsereignis

» Wertednderung eines Signals
» (Re-) Aktivierung eines Prozesses nach Wartezeit
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VHDL - Simulation (cont.)

VHDL - Simulation VHDL-Einfiihrung

= Ereignisgesteuerte Simulation

» theoretisches Modell
» veranschaulicht Semantik fiir den VHDL-Benutzer
» praktische Implementation durch Simulationsprogramme weicht
(aus Performanzgriinden) in der Regel davon ab
» vielfaltige Optimierungsmoglichkeiten
> compilierende Simulation
Ausnutzen von Datenabhangigkeiten
zyklenbasierte Simulation
Hardwareemulation
mixed-mode Simulation

vVvyVvYyyvyy
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Ereignisgesteuerte Simulation

Beispiel: Datenpfad

opA <= regBank(aSel) with opCode select regP: process (clk) is
when opMode=regM else alu <= opA + opB when opcAdd, begin
dataBus; opA - opB when opcSub, if rising_edge(clk) then
opA and opB when opcAnd, aluR <= alu;
regBank (0) end if;

end process regP;

regBank (1)

opA
‘ MUX ———————————

A o8 clk
dataBus - - -L - —- [ . D

aSel A
opMode opCode

000
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Ereignisgesteuerte Simulation — Zyklus 1

1. Simulationsereignis Ereignisliste

NOW aSel 1
opMode regM
opCode opcAdd

+10ns clk 1’
opA <= regBank(aSel) with opCode select regP: process (clk) is
when opMode=regM else alu <= opA + opB when opcAdd, begin
dataBus; opA - opB when opcSub, if rising_edge(clk) then
opA and opB when opcAnd, aluR <= alu;
regBank (0) et end if;
end process regP;
regBank (1)
OpA
i 1 S MUX ————
I 1 S

F 1 opB clk
dataBus - - -L - —- [ . DD

aSel A
opMode opCode
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Ereignisgesteuerte Simulation — Zyklus 1
1. Simulationsereignis
2. Prozessaktivierung

OpA <= regBank(aSel) with opCode select regP: process (clk) is
when opMode=regM else alu <= opA + opB when opcAdd, begin
dataBus; opA - opB when opcSub, if rising_edge(clk) then
opA and opB when opcAnd, aluR <= alu;
regBank (0) end if;

end process regP;

regBank (1)

opA
‘ MUX ——————————

000

A o8 clk
dataBus - --L - —- - i e, = IS0
aSel
opMode opCode
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2. Prozessaktivierung

3. Aktualisierung der Signaltreiber

opA <= regBank(aSel)
when opMode=regM else

dataBus;

regBank (0)

regBank (1)

regBank (15)

U B

A. Mider

000

1
opMode

MUX ————

with opCode select

alu <= opA + opB when opcAdd,
opA - opB when opcSub,
opA and opB when opcAnd,

OpA

[ ———

opCode

ALU —————— | Reg.

A

Ereignisgesteuerte Simulation — Zyklus 1

1. Simulationsereignis

oph =] NOW [ 45
s | 16 J

Ay | NOW | 4
L2 | a0 J

regP: process (clk) is

begin

if rising_edge(clk) then

aluR <= alu;
end if;
end process regP;

alu

clk

aluR

15



Ereignisgesteuerte Simulation — Zyklus 2

Zeitschritt: +6 Simulationsereignisse Signaltreiber
+4 opA 16

NOW +4
alu 49 alu -
+10ns clk 1’ L | 28 J

opA <= regBank(aSel) with opCode select regP: process (clk) is
when opMode=regM else alu <= opA + opB when opcAdd, begin
dataBus; opA - opB when opcSub, if rising_edge(clk) then
opA and opB when opcAnd, aluR <= alu;
regBank (0) s end if;

end process regP;

regBank (1)

opA
MUX ———————

A 12 clk
dataBus - - -L - —- - D

) A

opMode opCode

000
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Ereignisgesteuerte Simulation — Zyklus 3

Zeitschritt: +10ns Simulationsereignisse Signaltreiber

+10ns «clk 1’

21uR ¢ NOW +9
25 28 )

opA <= regBank(aSel) with opCode select regP: process (clk) is
when opMode=regM else alu <= opA + opB when opcAdd, begin
dataBus; opA - opB when opcSub, if rising_edge(clk) then
opA and opB when opcAnd, aluR <= alu;
regBank (0) et end if;

end process regP;

regBank (1)

MUX ————

F 1 opB clk
dataBus - - -L - —- [ . DA

A

000

aSel
opMode opCode
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Zyklenbasierte Simulation
> Diskretes Zeitraster: Takt bei Register-Transfer Code

> In jedem Zyklus werden alle Beschreibungen simuliert

» Sequenzialisierung der Berechnung entsprechend den

Datenabhangigkeiten
opA <= regBank(aSel) with opCode select regP: process (clk) is
when opMode=regM else alu <= opA + opB when opcAdd, begin
dataBus; opA - opB when opcSub, if rising_edge(clk) then
opA and opB when opcAnd, aluR <= alu;
regBank (0) end if;
end process regP;
regBank (1)
o OopA
; bog MUX ————————»
' o
r A opB clk
dataBus - --L - - - -0 > i >
aSel
opMode opCode
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VHDL - Simulationszyklus

VHDL - Simulation VHDL-Einfiihrung

Semantik der Simulation
» Kausalitat

1. Simulationsereignis Simulationszyklus,
2. Aktivierung des konkurrenten Codes
3. Signalzuweisungen in der Abarbeitung

4. Erneute Signalanderung Simulationszyklus, 1
» Trennung der Zyklen

= Simulation ist unabhingig von der sequenziellen
Abarbeitungsreihenfolge durch den Simulator

= auch bei mehreren Events in einem Zyklus,
bzw. bei mehrfachen Codeaktivierungen pro Event
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VHDL - Simulationszyklus (cont.)

Prozesse / Umgebungen von sequenziellem Code

» standig aktiv = Endlosschleife
1. Sensitiv zu Signalen

» Aktivierung, bei Ereignis eines Signals
» Abarbeitung aller Anweisungen bis zum Prozessende

ALU_P: process (A, B, ADD_SUB) is
begin
if ADD_SUB then X <= A + B;
else X <= A - B;
end if;
end process ALU_P;

2. explizite wait-Anweisungen

» Warten bis Bedingung erfiillt ist
» Abarbeitung aller Anweisungen bis zum nachsten wait
» Prozessende wird ,,umlaufen” (Ende einer Schleife)

A. Mider 20



VHDL - Simulationszyklus (cont.)

VHDL - Simulation

Beispiel: Erzeuger / Verbraucher

signal C_READY, P_READY : boolean --
signal CHANNEL 8 ooo --

PRODUCER_P: process is ==

begin
P_READY <= false;
wait until C_READY;

CHANNEL <= ... ==

P_READY <= true;
wait until not C_READY;
end process PRODUCER_P;

CONSUMER_P: process is -
begin

C_READY <= true;

wait until P_READY;

C_READY <= false;

o <= CHANNEL; -

wait until not P_READY;

end process CONSUMER_P;

Semaphore
Kanal

Erzeuger

generiert Werte

Verbraucher

verarbeitet Werte




VHDL - Simulationszyklus (cont.)
Signalzuweisungen im sequenziellen Kontext

» sequenzieller Code wird nach der Aktivierung bis zum
Prozessende / zum wait abgearbeitet

» Signalzuweisungen werden erst in folgenden Simulationszyklen
wirksam, frithestens im nachsten é-Zyklus

= eigene Zuweisungen sind im sequenziellen Kontext des
Prozesses nicht sichtbar

process ... process ...
if SWAP = ’'1’ then -- Werte tauschen NUM <= 5; -- Zuweisung
B <= A; -- B = ‘altes‘ A
A <= B; -- A = ‘altes‘ B if NUM > 0 then -- ggf. /=5 11!
end if;



Entwurfsspezifische Eigenschaften

» Strukturbeschreibungen / Hierarchie
> Instanzen component configuration

> Schnittstellen entity
> Versionen und Alternativen (exploring the design-space)
architecture configuration

» Management von Entwiirfen

> Bibliotheken library

> Code-Reuse package
VHDL-Erweiterungen: Datentypen, Funktionen ...
Gatterbibliotheken

spezifisch fiir EDA-Tools (Electronic Design Automation)
eigene Erweiterungen, firmeninterne Standards . . .

vV vy vy
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VHDL - Entity

VHDL - VHDL Einheiten VHDL-Einfiihrung

» Beschreibung der Schnittstelle , black-box*

DEL_LEN

DELAY_LINE

= DATA_OUT

> m|t Parametern generic
BIT_WD
> mit Ein- / Ausgdngen  port DATA_TN =
CLK —
parametrierbare Verzégerungsleitung
library ieee;
use ieee.std_logic_1164.all;
use ieee.numeric_std.all;
entity DELAY_LINE is
generic (BIT_WD : integer range 2 to 64 := 16;
DEL_LEN : integer range 2 to 16 := 16);
port ( CLK : in  std_logic;
DATA_IN : in  signed(BIT_WD-1 downto 0);
DATA_OUT : out signed(BIT_WD-1 downto 0));

end entity DELAY_LINE;

A. Mider



VHDL — Architecture

VHDL - VHDL Einheiten VHDL-Einfiihrung

» Implementation einer Entity
» mehrere Architekturen moglich = Alternativen

» Deklarationsteil: Typen, Signale, Unterprogramme,
Komponenten, Konfigurationen
Anweisungsteil: Prozesse, konkurrente Anweisungen, Instanzen

architecture BEHAVIOR of DELAY_LINE is

type DEL_ARRAY_TY is array (1 to DEL_LEN) of signed(BIT_WD-1 downto 0);
signal DEL_ARRAY : DEL_ARRAY_TY;
begin
DATA_OUT <= DEL_ARRAY (DEL_LEN);
REG_P: process (CLK) is
begin

if rising_edge (CLK) then
DEL_ARRAY <= DATA_IN & DEL_ARRAY(1 to DEL_LEN-1);
end if;
end process REG_P;
end architecture BEHAVIOR;
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VHDL - strukturell

» Hierarchie
» funktionale Gliederung des Entwurfs
> reprasentiert Abstraktion
> Instanziierung von Komponenten
1. Komponentendeklaration component

> im lokalen Kontext
> in externen Packages

2. Instanz im Code verwenden

> im Anweisungsteil der Architecture
» Mapping von Ein- und Ausgangen / Generic-Parametern

3. Bindung: Komponente < Entity+Architecture

> lokal im Deklarationsteil for ... use ...
> als eigene VHDL-Einheit configuration
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VHDL — strukturell (cont.)

» Komponente: lokale Zwischenstufe im Bindungsprozess

» andere Bezeichner, Schnittstellen (Ports und Generics)
bei Bibliothekselementen wichtig

2-stufige Abbildung

1. Instanz in Architektur < Komponente

2. Komponente < Entity+Architecture

., Default“-Konfiguration

vy

v

> gleiche Bezeichner und Deklaration
> zuletzt (zeitlich) analysierte Architektur

> strukturierende Anweisungen

» Gruppierung block

» konkurrenten Code (Prozesse, Anweisungen, Instanzen ...)
> bedingt ausfiihren if ... generate
» wiederholt ausfiihren for ... generate
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VHDL — strukturell (cont.)

VHDL - struktureller Code VHDL-Einfiihrung

Beispiel als Strukturbeschreibung von Registern: REG

» Die Register sind als eigene VHDL-Entities / -Architekturen
woanders definiert

REG_I(1) REG_I(2) REG_I (DEL_LEN)
BIT_WD|  WIDTH
DATA_IN ———» —------ e ———-= DATA_OUT
REG REG ooo REG

akR— L
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VHDL — strukturell (cont.)

VHDL - struktureller Code

architecture STRUCTURE of DELAY_LINE is

component REG is -- 1. Komponentendeklaration
generic( WIDTH : integer range 2 to 64);
port ( CLK : in std_logic;

D_IN : in  signed(WIDTH-1 downto 0);

D_OUT : out signed(WIDTH-1 downto 0));

end component REG;
type DEL_REG_TY is array (0 to DEL_LEN) of signed(BIT_WD-1 downto 0);
signal DEL_REG : DEL_REG_TY;
begin
DEL_REG (0) <= DATA_IN;
DATA_OUT <= DEL_REG(DEL_LEN);
GEN_I: for I in 1 to DEL_LEN generate
REG_I: REG generic map (WIDTH => BIT_WD) -- 2. Instanziierung
port map (CLK, DEL_REG(I-1), DEL_REG(I));
end generate GEN_I;
end architecture STRUCTURE;




VHDL — strukturell (cont.)

VHDL - struktureller Code VHDL-Einfiihrung

Konfigurationen

1. Auswahl der Architektur durch eindeutigen Bezeichner

configuration DL_BEHAVIOR of DELAY_LINE is
for BEHAVIOR

end for;

end configuration DL_BEHAVIOR;

2. Bindung von Instanzen in der Hierarchie

configuration DL_STRUCTURE of DELAY_LINE is
for STRUCTURE
for GEN_I
for all: REG use entity work.REG(BEHAVIOR);
end for;
end for;
end for;
end configuration DL_STRUCTURE;
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VHDL - Entwurfsmethodik

VHDL - Entwurfsmethodik VHDL-Einfiihrung

» VHDL Abstraktion: von Algorithmen- bis zur Gatterebene
= eine Sprache als Ein- und Ausgabe der Synthese
» Synthese: ab der RT-Ebene

» Abbildung von Register-Transfer Beschreibungen auf
Gatternetzlisten
» erzeugt neue Architektur, Entity bleibt

High-Level Synthese

» eingeschrankter ,,Suchraum"”, feste Zielarchitektur
» spezielle Anwendungsfalle

» Simulation

» System-/Testumgebung als VHDL-Verhaltensmodell
» Simulation der Netzliste durch Austausch der Architektur
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VHDL-basierter Entwurfsablauf

VHDL - Entwurfsmethodik

Systemumgebung

Spezifikation
__________ F--
q g |
Algorithmendesign / )
i
|
‘ Strukturierung ‘ ‘ VHDL Simulation }- — - - | Schaltungsfehler
|
|
|
I
l
__________ | Sp—
1
Architekturdesign +Takt / :
i
|
_ Synthese VHDL Simulation - - - — ! Schaltungsfehler
Library Mapping i
U 1
— —! Syntheseparameter

|

| synthesegerechtes VHDL
- -
|

Synthese

‘ Standardzell- / ‘ ‘ VHDL / Timingfehler

FPGA- Backend Verilog Simulation

+Leitungslaufzeit

Layout Datenbasis

Layout




VHDL — Entwurfsmethodik (cont.)

VHDL - Entwurfsmethodik VHDL-Einfiihrung

» Modellierung der Systemumgebung

» Simulation auf allen Abstraktionsebenen

Algorithmenebene

RT-Ebene

Gatterebene

Layout

Auswahl verschiedener Algorithmen
keine Zeitmodelle

Datenabhéangigkeiten: Ein-/Ausgabe (Protokolle)
Taktbasierte Simulation

+ Gatterverzégerungen

+ Leitungslaufzeiten

» Synthese ab der Register-Transfer Ebene

A. Mider



Gliederung

1. VHDL

2. Hardwarebeschreibungssprachen
VHDL-AMS
Verilog / SystemVerilog
SystemC
Beispiele
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VHDL-AMS

VHDL-AMS — Analog and Mixed Signal
» Analoge VHDL Erweiterung IEC 61691-6

» VHDL Obermenge: digitale Systeme werden wie in ,normalem*
VHDL modelliert

» ,mixed-signal”: gemischte analog-digitale Systeme
~multi-domain*: elektrische + nicht-elektrische Systeme

» analoge Modellierung: Differentialgleichungssysteme deren freie
Variablen durch einen Lésungsalgorithmus (,,analog Solver*)
bestimmt werden

» analoge Erweiterung der Simulationssemantik

» Anpassung der Paradigmen (diskret <> kontinuierlich)
fir das Zeit- und Wertemodell
» Wann wird der Solver aufgerufen?
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VHDL-AMS (cont.)

Hardwarebeschreibungssprachen - VHDL-AMS VHDL-Einfiihrung
Anwendungen

» analoge Systeme

» mikromechanische Systeme

» mechanische Komponenten
Modellierung der Schnittstellen zu mechanischen Komponenten
Beispiel: Ansteuerung eines Motors, Simulation von
> analogem Treiber

> elektromagnetischem Verhalten des Motors
» Massentragheit und Last
>
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VHDL-AMS (cont.)

Hardwarebeschreibungssprachen - VHDL-AMS VHDL-Einfiihrung

Erweiterungen
» Datentypen

> nature: zur Modellierung verschiedener Doméanen

subtype VOLTAGE is real tolerance "TOL_VOLTAGE";
subtype CURRENT is real tolerance "TOL_CURRENT";

nature ELECTRICAL is VOLTAGE across

CURRENT through
GROUND reference;

» Objekte/Ports
> terminal: Referenzpunkt
Knoten eines elektrischen Netzes, Ort im mechanischen System
> quantity: Werte die (zeitkontinuierlich) berechnet werden
Variablen des Gleichungssystems
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Hardwarebeschreibungssprachen - VHDL-AMS VHDL-Einfiihrung

> Anweisungen

A. Mider

>

simultane Anweisung: Beschreibung einer Gleichung,

partiell definierte Systeme (if, case-Falle) sind méglich

break: steuert die Zusammenstellung der Gleichungssysteme des
»analog Solvers" beispielsweise bei Diskontinuitaten
procedural: analoges Aquivalent zum process



VHDL-AMS - Beispiele

Hardwarebeschreibungssprachen - VHDL-AMS
» Diode: charakteristische Gleichungen

is - (e(vd—rs-id)/n-vt _ 1)

d
i = E(tt-id—Q-cj-\/vj2—vj-vd)

library ieee, AMS_LIB;
use ieee.math_real.all;
use AMS_LIB.ELEC_ENV.all;

entity DIODE is
generic ( ISS : real := 1.0e-14;

N : real 1.0;
TT, CJ®, V], RS : real := 0.0);
port ( terminal ANODE, CATHODE : ELECTRICAL);

end entity DIODE;

architecture LEVEL® of DIODE is
quantity V_D across I_D, I_C through ANODE to CATHODE;
quantity Q_C : CHARGE;
constant VT : real 1= 0.0258;

begin
ID == ISS * (exp((V_D-RS*I_D)/(N*VT)) - 1.0);
Q_C (TT * I_D) - (2.0 * CJO® * sqrt(V]**2 - VI*V_D));
I_C == Q_C’dot;

end architecture LEVELO;

A. Mider

RS

VHDL-Einfiihrung

ANODE

CATHODE



VHDL-AMS - Beispiele (cont.)

Hardwarebeschreibungssprachen - VHDL-AMS

» hiipfender Ball

library ieee, AMS_LIB;
use ieee.math_real.all;
use AMS_LIB.MECH_ENV.all;

entity BOUNCER is

generic ( S_INI : DISPLACEMENT := 10.0;
V_INI : VELOCITY = 0.0);

end entity BOUNCER;

architecture BALL of BOUNCER is

quantity S : DISPLACEMENT := S_INI; S
quantity V : VELOCITY := V_INI;
constant G : REAL := 9.81;
constant AIR_RES : REAL = 0.1;
begin
break V => -V when not S’above(0.0);
S’dot == V;
if V > 0.0 use V’dot == -G - V**2 * AIR_RES; T
else V’dot == -G + V**2 * AIR_RES;
end use;

end architecture BALL;

40



Verilog / SystemVerilog

Hardwarebeschreibungssprachen - Verilog / SystemVerilog

VHDL-Einfiihrung

» Hardwarebeschreibungssprache
» Verhaltensbeschreibung (auf Gatter- und RT-Ebene)

SystemVerilog auch auf héheren Ebenen

» Strukturbeschreibung, Hierarchien

» Entwicklung

» 1985 urspriinglich proprietére Sprache / Simulator
» 1995 IEEE/IEC Standard, regelmaBige Uberarbeitungen IEEE 1364
» 2005 aktuelle Erweiterung: SystemVerilog IEEE 1800

Vorteile

» sehr kompakter Code, wird gerne als Netzlistenformat genutzt
— haufig geduBerte Kritik an VHDL: , deklarativer Overhead" —
» Simulation

>
>

=

A. Mider

sehr schnell: alter als VHDL — Algorithmen besser optimiert
»golden Simulation®: finale Simulation(en) der Netzliste mit
extrahierten Leitungslaufzeiten vor der Fertigung

inzwischen einheitliche Simulatorengines



Verilog / SystemVerilog (cont.)

Hardwarebeschreibungssprachen - Verilog / SystemVerilog VHDL-Einfiihrung

(System)Verilog oder VHDL
» kein Unterschied bei den Modellierungsméglichkeiten

» oft werden Komponenten beider HDLs gemeinsam eingesetzt
» EDA-Werkzeuge: Synthese, Simulation

» ein internes Datenformat
» unterschiedliche |, frond-Ends*

Links

» https://accellera.org
https://www.eda-twiki.org
https://www.asic-world.com/systemverilog
https://www.asic-world.com/verilog
https://electrosofts.com/systemverilog
https://electrosofts.com/verilog

vV v.v v v .Y

https://en.wikipedia.org/wiki/SystemVerilog
» https://en.wikipedia.org/wiki/Verilog
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Hardwarebeschreibungssprachen - SystemC VHDL-Einfiihrung

» C++ basiert: Klassenbibliotheken mit
» hardware-nahen Datentypen
» Simulatorkern
= Executable ist der Simulator

Application

Written by the end user

Methodology- and technology-specific libraries

SystemC verification library, bus models, TLM interfaces

Core Language | Predefined channels | Utilities Data types

Modules Signal, clock, FIFO, Report handling, 4-valued logic type

Ports mutex, semaphore tracing 4-valued logic vectors
Exports Eiltni\{g%?éf:ision integers
Processes Limited-precision integers
Interfaces Fixed-point types
Channels pointyp

Events

Programming language C++
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SystemC (cont.)

» Semantische Erweiterungen fiir den Hardwareentwurf

» Konkurrente Modelle: Prozesse
Zeitbegriff: Clocks
» Reaktivitat (Ereignisse in VHDL): Waiting, Watching . ..
» Kommunikationsmechanismen: Signale, Protokolle
>
>

v

Hierarchie: Module, Ports . ..

» Entwicklung

» 2000 OSCI — Open SystemC Initiative
» 2005 IEEE/IEC Standard IEEE 1666
» Schrittweise Entwicklung

Links
» https://accellera.org
> https://www.asic-world.com/systemc

> https://en.wikipedia.org/wiki/SystemC
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SystemC (cont.)

Hardwarebeschreibungssprachen - SystemC VHDL-Einfiihrung

Idee/Vorteile

» Hard- und Software gemeinsam beschreiben:
Hardware-Software Co-Design

= durchgangiger, Werkzeug-unterstitzter Entwurfsablauf

C, C++
System Level Model

»
=] systemC Model

Manual Conversion

N

VHDL/Verilog

@ = Refinement

Results

Rest of Process

Rest of Process
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SystemC (cont.)

= hohere Abstraktionsebenen

+ C/C++ Infrastruktur nutzen: Compiler, Debugger . ..

+ Know-How nutzen:
jeder Softwareentwerfer kann damit auch , Hardware machen*

-+ Einfache Integration von eigenem Code und Erweiterungen
Praxis

+ Ersatz fir (proprietare) High-Level Simulation

— macht den C++ Programmierer nicht zum Hardwaredesigner
— noch mehr Deklarationsoverhead als bei VHDL

— Unterstiitzung durch EDA-Werkzeuge

Kunst des Hardwareentwurfs
Guten, synthesefahigen Code zu erstellen ... gilt fiir alle HDLsJ
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Beispiele
D-Flipflop mit asynchronem Reset

Hardwarebeschreibungssprachei

» VHDL: dff.vhd

library ieee;
use ieee.std_logic_1164.all;

entity DFF is

port ( CLOCK : in  std_logic;
RESET : in  std_logic;
DIN : in  std_logic;
DOUT : out std_logic);

end entity DFF;

architecture BEHAV of DFF is

begin
DFF_P: process (RESET, CLOCK) is
begin
if RESET = ’1’ then

DOUT <= ’0’;
elsif rising_edge(CLOCK) then
DOUT <= DIN;
end if;
end process DFF_P;
end architecture BEHAV;

A. Mider

VHDL-Einfii




Beispiele (cont.)

D-Flipflop mit asynchronem Reset

Hardwarebeschreibungssprachen - Beispiele VHDL-Einfiihrung

> Verilog: dff.v

module dff (clock, reset, din, dout);
input clock, reset, din;
output dout;

reg dout;

always @(posedge clock or reset)
begin
if (reset)
dout = 1’b0;
else
dout = din;
end
endmodule
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Beispiele (cont.)

D-Flipflop mit asynchronem Reset

Hardwarebeschreibungssprachen - Beispiele VHDL-Einfiihrung

» SystemC: dff.h

#include "systemc.h"

SC_MODULE (dff)

{ sc_in<bool> clock;
sc_in<bool> reset;
sc_in<bool> din;
sc_out<bool> dout;

void do_ff()
{ if (reset)
dout = false;
else if (clock.event())
dout = din;

1;

SC_CTOR (dff)

{ SC_METHOD (do_£ff);
sensitive(reset);
sensitive_pos(clock);

}

s
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Beispiele
8-bit Zahler, synchron riicksetz- und ladbar

Hardwarebeschreibungssprachen - Beispiele VHDL-Einfiihrung

» VHDL: counter.vhd

library ieee;
use ieee.std_logic_1164.all;
use ieee.numeric_std.all;

entity COUNTER is

port ( CLOCK : in  std_logic;
LOAD : in  std_logic;
CLEAR : in  std_logic;
DIN : in unsigned (7 downto 0);
DOUT : out unsigned (7 downto 0));

end entity COUNTER;
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Beispiele (cont.)

8-bit Zahler, synchron riicksetz- und ladbar

Hardwarebeschreibungssprachei ispi VHDL-Einfii

architecture BEHAV of COUNTER is
signal CNTVAL : unsigned (7 downto 0);

begin
CNT_P: process (CLOCK) is
begin
if rising_edge(CLOCK) then
if CLEAR = ’1’ then
CNTVAL <= (others=>'0’);
elsif load = '1’ then
CNTVAL <= DIN;
else
CNTVAL <= CNTVAL + 1;
end if;
end if;

end process CNT_P;

DOUT <= CNTVAL;
end architecture BEHAV;



Beispiele (cont.)

8-bit Zahler, synchron riicksetz- und ladbar

Hardwarebeschreibungssprachen - Beispiele VHDL-Einfiihrung

» Verilog: counter.v

module counter(clock, load, clear, din, dout);

input clock, load, clear;
input [0:7] din;

output [0:7] dout;

wire [0:7] dout;

reg [0:7] cntval;

assign dout = cntval;

always @(posedge clock)
begin
if (clear)
cntval = 0;
else if (load)
cntval = din;
else
cntval = cntval + 1;
end
endmodule
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Beispiele (cont.)

8-bit Zahler, synchron riicksetz- und ladbar

Hardwarebeschreibungssprachen - Beispiele VHDL-Einfiihrung

» SystemC: zwei Dateien

counter.h
#include "systemc.h"

SC_MODULE (counter)

{ sc_in<bool> clock;
sc_in<bool> load;
sc_in<bool> clear;
sc_in<sc_uint<8> > din;

sc_out<sc_uint<8> > dout;

int cntval;
void onetwothree();

SC_CTOR (counter)
{ SC_METHOD (onetwothree);
sensitive_pos (clock);
}
3
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Beispiele (cont.)

8-bit Zahler, synchron riicksetz- und ladbar

Hardwarebeschreibungssprachen - Beispiele

counter.cc

#include "counter.h"

void counter::onetwothree()

{ if (clear)
cntval = 0;
else if (load)

cntval = din.read();

else
cntval ++;

}

dout = cntval;

A. Mider

VHDL-Einfiihrung

// read for type conversion from input port
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